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• Imperfective verbs: The [–pf] feature prevents
the system from deriving a coherent semantics
for [perfect].

Returning to the folklore mentioned in the intro-
duction, aspect is a grammatical category in Rus-
sian: verbs in all contexts must be either perfective
or imperfective (or in our terms, to occur in clauses
where Asp is either [+pf] or [–pf]). But, according
to this study, is not true that all lexemes have
perfective and imperfective forms, since verbs with
lexically marked aspect do not. As perfective aspect
of verbs without lexical marking can only be
derived on the basis of telic aspectuality, only
verbs with internal arguments that can partici-
pate in the derivation of a value for aspectuality
occur in such true aspectual pairs (whether the
aspectual morphology is pre- or suffixal). Such
verbs may be transitive or unaccusative, which, as
Schoorlemmer indicates, in turn provides a very
powerful diagnostic for unaccusativity in Russian:
if an intransitive verb shows aspectual pairing it
must have an internal argument at least in the
perfective, and therefore it must be an unaccusa-
tive verb.

A few months ago, I put the finishing touches on a
manuscript I’d been revising. Previous to my
revisions, it had sixty seven examples and four
major section headings; once I was done, I had
seventy three examples, and five major section
headings. Further, I’d reversed the order of two of
major sections. My final task then, before sending
the paper off to a journal, of course, was to go
through the whole document and renumber all
the examples, all the references to those examples
in the text and all the section headings. It took me
the better part of a day to do this, and even then,
I discovered that I’d made a mistake in renumber-
ing around example (20), and had to do it all over
again. Frustration reigned! Despite my general
love for computers and all that they could do, and
despite my strong views against sweatshop labor, I
almost yearned for the days when academics
regularly had assistants that they could assign
such boring tasks to. I knew then that I had to
finally take the plunge and invest in some soft-
ware that could do the work for me.

This is not the first time I’ve toyed with auto-
matic example-renumbering programs. Betsy
Ritter introduced me to Jonathan Mead’s RENUM-
BER program in 1995. This program serves as a
filter on the output of word processors, and re-
numbers specially marked symbols. Each example
is given a tag (e.g. $N1) and each reference to
that example is given an identical tag. Once you
are finished editing the document, you save it in
rich text format (RTF), run it through RENUM-
BER, then decode it back into normal format. I
gave it a fair try, and for the most part it seemed
to work well. It did have its down sides: I found
the tags very distracting, especially if I was trying
to put some finer touches on the formatting. I was
also disappointed in the fact that if I wanted to
continue to use the renumbering features, I al-
ways had to be certain that I was editing a version
of the document with the tags, rather than the
output of the renumber program. This meant I
had to keep two copies of every document. More
than once I made changes to the wrong version of
documents, and had to go back and do them
again. I was also, I admit, far too lazy to use this
program consistently. The program is shareware,
and in 1995 cost $20 (I’m not sure if it is still
available). After an initial flirtation, I quickly
found myself back in the land of manual renum-
bering, and decided to spend my $20 on books
instead.

In 1992, 1994 and 1996, there was some
discussion in the LINGUIST list as to various pro-
grams and scripts that people could run to renum-
ber their examples. These discussions can be
found at:

http://linguistlist.org/issues/3/3-956.html#2
http://linguistlist.org/issues/5/5-637.html#1
http://linguistlist.org/issues/7/7-1675.html#1

Suggestions ran from a number of scripts and
applets which people had written to purchasing
the language oriented word processor: Nisus
Writer. Although I read the discussions with
interest, inertia kept me from trying any of these
options.

When Microsoft announced that Word98
contained automatic list renumbering features, my
heart skipped a beat. ‘Finally’, I thought, ‘I can
just get my word processor to do it for me.’ I was
initially not only disappointed with the results, but
incredibly frustrated. Like most people, I had no
desire to work my way through Word98’s poorly

designed help features. So I just started in. Word
automatically numbered for me, it is true, but it
didn’t do it in any coherent way that I saw. Regu-
lar text intervening between examples (as is
standard in our discipline) seemed to throw the
sequence off. Numbered section headers also
seemed to throw a spanner in the works. Word
kept trying to automatically renumber my section
headings as part of my example numbers. Fur-
ther, it isn’t at all obvious how to make reference
to these numbers in the body of the text. With one
particular document I was working on, the se-
quence of numbers as automatically generated by
Word98 was 1,2,3,47,48,32,33,34,4,5,6. Don’t ask
me how that happened, I’m still not sure. Much
swearing resulted, and I turned the automatic
numbering off (which in itself was not a task for
the faint of heart). This said, these kinds of prob-
lems could easily have been resolved if I’d both-
ered to do a little more background research. In
fact, renumbering and cross-referencing are
incredibly easy, and work quite well. After some
initial pain in setting it up, it will work for all your
documents. Below, I’ve set out the steps for setting
up Word98 to renumber and cross-reference a
typical linguistics document. The initial task is
rather long and daunting, but once it’s done, you
never have to do it again, and you’ll be free and
clear with renumbering.

The keys to making renumbering work cor-
rectly are three concepts from typesetting: styles,
templates and cross-referencing. Styles are
essentially prepackaged (or user defined) bundles
of formatting features. They can also be used to
mark off certain text (like examples or headings)
so that functions like renumbering apply only to
them and not to other parts of the document. Once
you’ve defined certain styles, the renumbering
feature works like a charm. The problem with
styles is that, with the exception of a few ugly
prepackaged ones, documents in Word98 don’t
have universal access to your user-defined styles.
This is where a template comes in handy. Tem-
plates are user-definable groups of document
formatting instructions. Templates include styles.
Part of the initial set-up in getting renumbering to
work is to create a template that you will use for
all your documents. The third tool is cross-refer-
encing. It is possible to refer to one part of the
document in another part if you’ve set things up
correctly. In particular you can cross reference
example numbers, tables, section headers and
even footnotes. I’ll now go through the steps
necessary to get you going in renumbering. What
I’m describing here is primarily for Word98 for
Macs. However, most of what I say should also be
true of Word97 and Word98 for PCs.

1. Setting up a template
First, you need to create a template that you

will use for all your documents. A stuffed example
of such a template can be found at

http://www.linguistlist.org/~carnie/papers/
Word.template.sit
Point at the File menu, and select New.... A dialog
box like (1) will appear on your screen.

Next, click on the Template toggle switch under
Create New, then click on the OK button. This
will bring up a window that looks suspiciously like
a blank document. Don’t be fooled, however, this is
not a document, but a template. At this stage you
can do all sorts of magical things, like typing in

COUNTING FOR LINGUISTS

By Andrew Carnie

An explanation of Microsoft Word98’s renumbering features

Price: NLG 55.05 (ex. 6% VAT where applicable, ex. P&P)
Individuals ordering directly from Holland Academic Graphics are

eligible for a 33% discount.

Holland Academic Graphics
P.O. Box

The Hague
The Netherlands

53292

2505 AG

mail hagpub.com
www.hagpub.com
fax: +

@

31 70 4480177

[  s  c  i  e  n  t  i  f  i  c       [  d  o  c  u  m  e  n  t  ]       p  r  o  c  e  s  s  i  n  g  ]

Recent dissertations from LOT
Advertisement

A unified account of binary and ternary stress, written in the context of
metrical theory, aims for a restrictive theory of stress systems
in natural languages.

In bounded stress systems the distance between stressed
syllables is kept to a maximum. Usually, the notion of
bounded stress is equated with binary alternation or binarity.
In binary stress systems the rhythmic distance between two
stressed syllables is at most one stressless syllable, while in
ternary systems the maximum distance is at most two
stressless syllables. Using OptimalityTheory Elenbaas aims to
contribute to metrical theory by offering a unified account of
binary and ternary stress systems.

The arguments are based on analyses of the stress systems of
Sentani and Finnish. Both languages have a basically binary
stress system, in which ternary patterns appear frequently.
The analysis of Sentani shows that the antilapse constraint,
which plays an important role in the analysis of ternary stress
systems, and which requires the avoidance of long sequences
of unstressed syllables, must be interpreted as a rhythmic
constraint, rather than as a parsing constraint.The analysis of
Finnish gives independent evidence for this antilapse
constraint, where it plays a crucial role in creating binary
stress patterns.

This book is of interest to anyone with a special interest in
metrical phonology and prosodic morphology.

1999. xii+216 pp. 9055690651. Paperback. [LOT International Series
20. UiL OTS Dissertation.]

ISBN

A unified account of
binary and ternary stress

Considerations from Sentani and Finnish
Nine Elenbaas

Price: NLG 55.05 (ex. 6% VAT where applicable, ex. P&P)
Individuals ordering directly from Holland Academic Graphics are
eligible for a 33% discount.

Holland Academic Graphics
P.O. Box

The Hague
The Netherlands

53292

2505 AG

mail hagpub.com
www.hagpub.com
fax: +

@

31 70 3595044

[  s  c  i  e  n  t  i  f  i  c       [  d  o  c  u  m  e  n  t  ]       p  r  o  c  e  s  s  i  n  g  ]

Recent dissertations from LOT
Advertisement

A unified account of binary and ternary stress, written in the
context of metrical theory, aims for a restrictive theory
of stress systems in natural languages.

In bounded stress systems the distance between stressed
syllables is kept to a maximum. Usually, the notion of
bounded stress is equated with binary alternation or
binarity. In binary stress systems the rhythmic distance
between two stressed syllables is at most one stressless
syllable, while in ternary systems the maximum distance
is at most two stressless syllables. Using Optimality
Theory Elenbaas aims to contribute to metrical theory
by offering a unified account of binary and ternary stress
systems.

The arguments are based on analyses of the stress
systems of Sentani and Finnish. Both languages have a
basically binary stress system, in which ternary patterns
appear frequently.The analysis of Sentani shows that the
antilapse constraint, which plays an important role in
the analysis of ternary stress systems, and which requires
the avoidance of long sequences of unstressed syllables,
must be interpreted as a rhythmic constraint, rather than
as a parsing constraint.The analysis of Finnish gives
independent evidence for this antilapse constraint,
where it plays a crucial role in creating binary stress
patterns.

This book is of interest to anyone with a special interest
in metrical phonology and prosodic morphology.

1999. xii+216 pp. ISBN 9055690651. Paperback.

[LOT International Series 20. UiL OTS Dissertation.]

A unified account of
binary and ternary stress

Considerations from Sentani and Finnish

Nine Elenbaas

http://linguistlist.org/issues/3/3-956.html#2
http://linguistlist.org/issues/5/5-637.html#1
http://linguistlist.org/issues/7/7-1675.html#1
http:\\www.hagpub.com


Goodies Glot International, Volume 4, Issue 3, March 1999 21

text that you want to appear in every document
(like a consistent running header or footer), or
change the margins. I found Gookin and Sydow’s
(1998) Word 98 for Macs for Dummies (Foster City,
CA: IDG books, US$20.00) an excellent introduc-
tion to playing with templates. What is most
important for renumbering, however, is the defin-
ing of styles.

2. Defining Styles
In order to do a standard linguistics docu-

ment, you’ll need at least 3 styles:
• a normal style for regular text,
• a style for examples,
• at least one style for headings.
Personally, I use three different heading styles,
which allows me to use different levels of subsec-
tions (e.g. 3., 3.1, and 3.1.1) with different format-
tings. To define a style, with your blank template
document open, go to the Format menu, and pull
down and select Styles. The style dialog box will
pop up as in (2).

(i) Start by clicking on the list bar and select All
styles. This will bring up a list of all the prede-
fined styles. First we’re going to edit the ‘Normal’
style. (ii) Make sure that the ‘Normal’ item is
highlighted in the style list. (iii) Next click on the
Modify button. A new dialog box will now pop
up (3).

At this stage you can do all sorts of fancy things,

such as changing the default font for the main
body of the text, changing your margins etc. This
is all done via the Format button (i) at the bottom
of the window. One crucial point to remember is to
make sure that the Add to template (ii) box is
clicked and that the Style for following para-
graph (iii) is set to ‘Normal’. I personally find it
easiest to manipulate styles if I have a keyboard
shortcut defined. You can assign a keyboard
shortcut by clicking on the Shortcut Key button
(iv). Once you have completely formatted the style
as you want it, you click on OK, to edit the next
style.

Next, we set up the headers. The basics are
the same: click on ‘Header 1’ in the styles window,
then click the Modify button. Again you can set
up the formatting exactly as you want it. To get
Word98 to renumber your section headers, you
have to add one important step here. Click on the
Format button, and pull down until you select
Numbering. A new dialog box will pop up (4).
Click on the tab that says Outline Numbered
(4i). Be sure to use ‘outline numbering’ and not
‘numbering’.

Select the format of header numbering you want
(or if you are really adventurous, click on custom-
ize and make your own!). I recommend the un-
indented 1, 1.1, 1.1.1 sequence (ii). Then click on
OK (iii). This is the function that will automatical-
ly number your headers. You will now be back in
the modify style box. Other important parameters

include making sure that the Add to template
box is clicked, and that the Style to follow is set
to ‘Normal’. Again, at this stage, you may want to
set up a shortcut key. When all this is done click
on OK, which will take you back to the Styles
box.

It is possible to have more than one heading
style (e.g., 1. MAIN HEADING, 1.1 Sub-heading etc.)
and yet keep the numbering sequential. To do
this, you simply modify the prepackaged styles
‘Heading 1’, ‘Heading 2’, ‘Heading 3’ etc. These
form a style family. The numbering will be consist-
ent throughout the family, but the actual format-
ting of individual styles may differ. ‘Heading 1’ is
for main section divisions (whole numbers: 1, 2, 3),
‘heading 2’ for subsections (1.1,1.2,1.3 etc) and
‘heading 3’ for sub-sub-sections (1.1.1, 1.1.2, 1.1.3
etc.) For more on styles and style families, see any
decent book on Word98 (e.g. Gookin and Sydow).

Finally, now that we’re experts in defining
styles, we need to define a style for numbered
examples. To define a new style, start by clicking
on the New button in the main Styles dialog box.
Up comes the New style dialog box. It looks
suspiciously like the Modify style box (3). Again,
you can format this as you like, by clicking on the
Format button. Also, once again, the Add to
template button should be clicked, the following
style should be ‘normal’ and you can set up a
shortcut key. The most important step here is to set
up the numbering. Again, this is reached by
clicking on Format and selecting Numbering,
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then clicking on the Outline Numbered tab.
Then select the numbering style you like. I like
the indented ‘1),a),i)’ sequence which is indicated
in (4iv) above. Using ‘outline numbering’ is partic-
ularly important if you want to have example
numbers with lettered sub-examples as in (5):

(5)
a) peanut butter
b) jelly
c) sandwiches

If you use Numbered instead of Outline Num-
bered, you won’t be able to do this. To finish up,
click OK, and then click OK again to get back to
the Style box. Somewhat counter-intuitively, you
next click on the Cancel button.

You have now defined all the styles for your
template. Save and close the template by choosing
Save from the File menu. Give your template a
name. It should be saved in the templates folder,
which is in the Microsoft Office98 or Word98
folder, which in turn is in your applications folder.
Finally, close the template by choosing Close from
the File menu. Be sure to do this before you start
work on any documents.

3. Using the styles to automatically
renumber
The hard part is now over, by having taken

the time to set up a template with styles, renum-
bering is a piece of cake. Start by opening a new
document. Don’t use the  button on the tool bar,
as this won’t allow you to access your template.
You have to use the New... selection under the
File menu. When the dialog box appears double
click on your template. A blank document will
open, with all your defined styles active.

There are two ways to access the styles; one is
by using any keyboard shortcut you may have
assigned. The other is by clicking on the down-
wards pointing arrow next to the rightmost menu
on the second tool bar (6).

When typing the body of your text, the style
should be ‘normal’. To make a numbered header,
simply change the style to the relevant ‘header’
style, and start typing. The number will appear
automatically. Similarly, when typing an example,
choose the ‘example’ style and start typing; the
number will appear automatically.

When typing an example with interlinear glosses
and a translation, only the first line of the exam-
ple should be in the ‘example’ style:

(7)
Tá stíl agam example style
Is style at.me normal style
“I have style” normal style

The number is inserted automatically as part of
the ‘example’ style.

If you want to have lettered examples, the tech-
nique is slightly more complicated. It is impossible
to have both a number and a letter on the same

line, so in order to use both; it is necessary to have
a blank first line. Start by typing the text you
want to be numbered, preceded by a single car-
riage return:

¶
first line of example
second line of example
third line of example

Then highlight the text and apply the ‘example’
style to all the lines including the carriage return

(8) ¶
(9) first line of example
(10) second line of example
(11) third line of example

This temporarily throws off your numbering, but
will be fixed in the next step. Next click your
mouse at the beginning of the first line that you
want lettered and insert a tab. The number should
automatically turn into a letter and the example
should indent:

(12) ¶ example style with no tab
a) ➡ first line of example example style with 1 tab
b) ➡ second line of example example style with 1 tab
c) ➡ third line of example example style with 1 tab

To get a third layer of numbering (e.g. i, ii, iii, etc),
insert an additional tab:

(13) ¶ example style with no tab
a) ➡ first line of example example style with 1 tab

(i)➡➡ second line of example example style with 2 tabs
(ii)➡➡third line of example example style with 2 tabs

Since headings, examples, and the main body of
the text are all in different styles, they don’t
interact with one another, and the number se-
quences should be distinct. If you want to see how
the renumbering works, you can go back and
insert an example and apply the ‘example’ style to
it, and you’ll see that all subsequent examples are
automatically renumbered.

4. Inserting references to examples in the text
Once you have created automatically renum-

bering examples, making similarly automatic
references to them in the body of the text is also
simple. This involves cross-referencing. Cross-
referencing only works if you have applied an
automatically numbered style to your examples. If
you insert the example numbers by hand, the
cross-referencing won’t work. To insert a reference
to an item into the text, the numbered item must
already be in the document. Consider the example
numbered (14):

(14) Cross-referencing is remarkably like binding theory

To cross-reference this item, you first put your
cursor where you want the reference to go. Next,
go to the insert menu, and select cross-refer-
ence. A dialog box like (15) will pop up.

(i) Under reference type, select numbered
item; (ii) under Insert reference to, select
Paragraph number. (iii) Next select the item
you want to make reference to. Then finally (iv),
click on the insert button. In your text where your
cursor was placed a number with a gray back-
ground will appear, looking like: 15). This is your
cross-reference. It will automatically renumber if
your examples change in number too.

While this works well in most cases, there are
a couple of annoying features that I find extreme-
ly distracting. When you insert the reference, the
cross-referencing automatically inserts the closing
bracket on the number. This means that to create
a standard kind of bracketing (such as ‘(15)’), the
first bracket “(“ must be typed manually, but the
second one is inserted automatically. While it is
possible to manually edit out the automatic brack-
et, one has to do it by hand for every single exam-
ple. On a related note, the only way to insert a
reference to a lettered sub-example of a numbered
example is to insert two cross-references: First, you
insert a cross-reference to the number, then a
second one to the letter. Unfortunately, since each
of these involves the insertion of a right bracket,
the result is particularly ugly: (14)a). Again,
manual correction is possible, but I found it irritat-
ing that I couldn’t turn this off somewhere. Final-
ly, it sometimes may appear as if the cross-refer-
ences aren’t automatically updating. If this occurs,
save and close the document, and then re-open it.
The act of opening the document seems to retrig-
ger the renumbering function.

5. Is it worth it?
At this point, those readers who have made it

this far through all the technical material will be
asking themselves if going through all this is
worth the bother. It isn’t trivial to set up the initial
template with all the right styles. It took me three
ruined templates, and a couple of hours to get it
right. Probably more difficult than setting up the
system, is remembering to use it. Before trying
this out, styles seemed to be strange exotica that
only copy-editors and typesetters might use.
Admittedly, at first blush, using styles is a tech-
nique beyond the ken of your average linguist,
who just wants to get their brilliant thoughts on
paper and has neither the time nor inclination to
work out the details of their word processor.

Despite all this, I’m now a convert. Setting up
the template can be a once-in-a-lifetime thing.
When you have your template in place, you can
use it for all your documents, if you so wish. If
you’ve set up shortcut keys, then using styles is no
more difficult than applying a new font or adding
italics. Similarly, using cross-referencing is simply
like choosing from a menu. I am fairly sure that
the initial investment of time will save me a great
deal of grief in the future.

A stuffed Macintosh copy of the template described
above can be uploaded from:
http://www.linguistlist.org/~carnie/papers/
Word.template.sit
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